About this Technote

In this technote, we discuss features in the APx500 measurement software that support the creation of automated production test sequences, with a focus on electro-acoustic test. We also illustrate the practical example of configuring APx for production test of loudspeakers.

Production Test in APx

From its inception, the APx500 software was designed with a new paradigm for audio test in mind—one in which engineers, even those with little audio experience, would be able to make industry standard audio measurements “within 5 minutes of opening the box.” Critically, the inclusion of a view called the Sequencer in version 1.0 provided production test designers with the ability to easily automate measurement sequences with only a few extra clicks, and without the need of API knowledge or programming experience.

Since that initial introduction, features such as a simplified Production Test view, automated TEDS calibration, and others have greatly expanded the set of tools available to production test designers while maintaining the ease of use to which APx software users have become accustomed.

In November of 2020, Audio Precision released the APx517—a complete, integrated solution for production test of electro-acoustic transducers. The APx517 reduces setup time and simplifies testing by integrating calibrated power and headphone amplifiers, current and voltage sensing outputs (for 4-wire Kelvin impedance measurements), as well as TEDS capable mic power supplies. The APx517 also has switchable power amplifier outputs and a digital module slot for optional Bluetooth™, PDM, HDMI, DSIO or SPDIF/TOSLINK/AES3 connectivity.

Although the APx517 is Audio Precision’s recommended production test solution, the information provided in this technote applies to all APx500 analyzers, including APx500 Flex.

Features supporting production test that are described in this technote include:

- Sequence Mode
- Sequences & the Navigator/Sequencer
- Signal Paths, Measurements, and Sequence Steps
- Variables
- Auxiliary control
- Data export and report generation
- Microphone calibration
- Output level regulation
- Defining limits/targets using a Golden Unit (reference device)
- Analog generator Global Vmax
- Input equalization
- Production Test mode (password-restricted)
- Sequence logging and statistics

About this Technote

In this technote, we discuss features in the APx500 measurement software that support the creation of automated production test sequences, with a focus on electro-acoustic test. We also illustrate the practical example of configuring APx for production test of loudspeakers.

Production Test in APx

From its inception, the APx500 software was designed with a new paradigm for audio test in mind—one in which engineers, even those with little audio experience, would be able to make industry standard audio measurements “within 5 minutes of opening the box.” Critically, the inclusion of a view called the Sequencer in version 1.0 provided production test designers with the ability to easily automate measurement sequences with only a few extra clicks, and without the need of API knowledge or programming experience.

Since that initial introduction, features such as a simplified Production Test view, automated TEDS calibration, and others have greatly expanded the set of tools available to production test designers while maintaining the ease of use to which APx software users have become accustomed.

In November of 2020, Audio Precision released the APx517—a complete, integrated solution for production test of electro-acoustic transducers. The APx517 reduces setup time and simplifies testing by integrating calibrated power and headphone amplifiers, current and voltage sensing outputs (for 4-wire Kelvin impedance measurements), as well as TEDS capable mic power supplies. The APx517 also has switchable power amplifier outputs and a digital module slot for optional Bluetooth™, PDM, HDMI, DSIO or SPDIF/TOSLINK/AES3 connectivity.

Although the APx517 is Audio Precision’s recommended production test solution, the information provided in this technote applies to all APx500 analyzers, including APx500 Flex.

Features supporting production test that are described in this technote include:

- Sequence Mode
- Sequences & the Navigator/Sequencer
- Signal Paths, Measurements, and Sequence Steps
- Variables
- Auxiliary control
- Data export and report generation
- Microphone calibration
- Output level regulation
- Defining limits/targets using a Golden Unit (reference device)
- Analog generator Global Vmax
- Input equalization
- Production Test mode (password-restricted)
- Sequence logging and statistics

www.ap.com
# Table of Contents

**About this Technote** .................................................. 1

**Production Test in APx** ........................................... 1

**Sequence Mode** ......................................................... 3

**Sequences** ................................................................. 3

**The Navigator/Sequencer** ............................................. 3
  - Signal Paths .......................................................... 3
  - Measurements and Results ....................................... 3
  - Sequence Steps ...................................................... 4
  - Adding Items to a Sequence ....................................... 5
  - Measurement Sequence Settings ................................ 6
  - Multiple Sequences ................................................ 6
  - Adding Sequences .................................................. 7
  - Editing Sequence Properties ..................................... 7

**Variables** ..................................................................... 7
  - Class 1: User defined variables .................................. 7
  - Class 2: APx System Variables ................................... 8
  - Class 3: Measurement Variables .................................. 8
  - Class 4: Environment Variables ................................... 8
  - Class 5: System Folders ............................................. 8
  - Variable Properties: Required and Persist .................... 8
  - Using Variables in Paths ............................................ 8

**Auxiliary Control** ....................................................... 9
  - Aux Control Sequence Settings ................................ 9
  - Dialog Button Aux Control Settings ........................... 10
  - The Set Aux Control Output Step ............................... 10

**Exporting data and reports** .......................................... 10
  - Export Steps .......................................................... 10
  - The Report Step ...................................................... 11
  - The Data Output step ............................................... 12

**Loudspeakers & Headphones—Special**

**Requirements for Production Test** ................................. 12

**Microphone Calibration** ................................................ 12
  - Acoustic Input Mode ................................................ 12
  - Calibrating from TEDS .............................................. 13
  - Using an Acoustic Calibrator .................................... 13

**Output Level Regulation** ............................................... 13

**Defining Limits/Targets Using Golden Units** ...................... 14
Sequence Mode

The APx500 software provides two operational modes: *Bench Mode*, for power users accustomed to having complete control of measurement hardware, and *Sequence Mode*, for applications that require measurement sequencing and report generation. For production test development, select “Sequence Mode”.

![Operating Mode selector](image1)

**Figure 1.** The Operating Mode selector, displayed in the upper right-most corner of the application.

Sequences

In APx500, a Sequence is a collection of Signal Paths, Measurements, and other items that execute in a defined order with the click of a mouse (or press of a button). A project file can contain up to 32 sequences, allowing test designers to create sequences to fulfill specific purposes. For example, in many test applications it’s common to create one sequence to run the calibration procedure, one to generate the Golden Unit reference data, and a third to test the DUT (device under test).

A new APx500 project file contains one Sequence: “Sequence 1”. Sequences are added and defined via the Sequencer, described in the next section.

The Navigator/Sequencer

In Sequence Mode, the Navigator/Sequencer (Figure 2) provides two key functions: it serves as a measurement Navigator, where you can add, delete or rename signal paths, measurements and results, and is displayed in a tree-and-branch structure. It also is the interface for the Sequencer, where you can select and reorder measurements and results, add prompts and build one or more sophisticated automated sequences, all from within the APx500 graphical interface.

Sequences, when run, execute all checked Sequencer items in descending order – from top to bottom. Unchecked items are excluded from the sequence. A sequence ends when the last checked item has been run, when the sequence is cancelled, or when a terminal failure condition occurs.

![Sequencer](image2)

**Figure 2.** The Navigator/Sequencer is the left-most pane in the software, directly above the Monitors/Meters panel.

Signal Paths

A Signal Path is a collection of analyzer settings and measurements. Analyzer settings defined in the signal path (such as connector and filter settings for both output and input) apply to all the measurements in the collection. A signal path can contain any number of measurements. To view or edit an existing signal path’s settings, click on the “Signal Path Setup” node below the signal path’s title (for example, below “Signal Path1”) in the Navigator.

To add a signal path, click the Add Signal Path row near the bottom of the Navigator/Sequencer (scroll down, if necessary), or click the button on the Sequencer toolbar.

Note that Signal Path Setup is sometimes referred to as a measurement since it includes meter results and diagnostic tools for verifying connections. Unlike other measurements added to signal paths, Signal Path Setup cannot be deleted and always exists as the first measurement in the signal path.

Measurements and Results

A Measurement is an entity that contains generator settings, analyzer settings, and results, all of which apply to a specific test application. The software provides a list of pre-defined measurements, each of which have been tailored for a particular use.

For example, a “THD+N” measurement (Figure 3) has controls to configure the sine stimulus and input filter settings that will be used when the THD+N measurement is made. When run, the THD+N measurement acquires several...
distortion and noise-related results such as THD+N Ratio, THD+N Level, THD Ratio, and Noise Level. Measurement results can be viewed, configured, added, or deleted using the thumbnail “filmstrip” shown in the bottom-right of the measurement view.

Note: filter settings defined in measurements override filter settings defined in signal paths. To use the parent signal path’s configuration, select “Signal Path” in the measurement’s filter settings.

Figure 3. The THD+N measurement.

As of the writeup of this technote, there are 60 measurements available on a fully-optioned APx517.

To add a measurement, select the signal path which will contain the measurement, then click the row beneath it (alternatively, click the button on the Sequencer toolbar). A window will appear, displaying a list of measurements (Figure 4). Select one or more measurements, then click the “Add & Close” button, which will add the measurement(s) directly below the current selection in the Navigator.

Figure 4. The Add Measurement dialog.

Sequence Steps

A Sequence Step executes an action at a specific point in a sequence — for example, prompting for a serial number or test station ID at the start of a DUT test sequence. Any number of sequence steps can be added as either pre-sequence, measurement, or post-sequence steps. A description of each type of sequence step follows.

Measurement Sequence Steps

Measurement sequence steps refer to steps that can be added to measurements — for example, to Loudspeaker Production Test (Figure 5) — and run at the time the measurement is run in the sequence. A variety of measurement sequence steps are available, providing the ability to:

- Prompt the operator (with an optional graphical image) to provide instructions or solicit input.
- Export data from a result in the parent measurement.
- Insert a time delay.
- Run an external command-line program.
- Calibrate from TEDS (Signal Path Setup only).
- Compensate for the measured output-to-input delay (Signal Path Setup only).
- Append a measurement.
- Set the state of the Aux Control Out bits to control an external device.
- Import a data set into a measurement result.
- Change channel assignments in attached audio switchers.
- Control the outputs of a DCX-127.
- Display a specific result during the test for an operator to observe.
- Request that the operator interact with the sequence by selecting Pass or Fail status for an observed measurement.
- Control interface-specific outputs on optional hardware modules (HDMI, PDM, Bluetooth™, and so on).

Note that while nearly all of the steps listed above can be added to any measurement, the ones that alter Signal Path settings can only be added to Signal Path Setup (for example, “Measure and Set DUT Delay”).

**Post-Sequence Steps**

Post-sequence steps (Figure 7) run at the end of the sequence, after all other items. An APx500 project file contains two steps by default: The Report node and the Data Output node (see “Exporting data and reports”).

**Pre-Sequence Steps**

Pre-sequence steps (Figure 6) are run at the start of a sequence, before any other item. An APx500 project file contains one pre-sequence step by default—the Device ID Prompt, optionally used to prompt for a DUT serial number. As shown, additional steps that can be added to the Pre-Sequence Steps node include prompts, running an external program, inserting a delay, or setting the Aux Control Out bit pattern to control an external device.

**Including Items in a Sequence**

To include an item in a Sequence, first select the appropriate Sequence using the “Sequence:” drop-down just above the Sequencer toolbar at the top of the Navigator, then check the box next to the item’s name. Checking a measurement node automatically checks all the results the measurement contains, however, individual results can be unchecked or rechecked as desired.

Signal paths, measurements, measurement results, and sequence steps can all be re-ordered by clicking and dragging the relevant item to the desired position in the Sequencer hierarchy.
Measurement Sequence Settings

In addition to generator and analyzer settings, each measurement has sequence settings that affect its behavior when run in a sequence.

Signal Path Setup Sequence Settings

Measurement Sequence Settings defining actions that occur at the beginning of a signal path are configured in Signal Path Setup. Settings unique to Signal Path Setup (i.e., not available to other measurements) include Auto Set Generator Level (see “Output level regulation”), Bluetooth device selection settings (available when using Bluetooth output/input only), and Copy Reference settings (which copy all references from another signal path). Copy Reference settings are typically used to copy references from a calibration signal path to a measurement signal path – for example, from the Calibrate Mic signal path shown in Figure 9 to the Acoustic Measurements signal path shown in the same image. See “Microphone Calibration” for further discussion of the microphone calibration process.

Failure Action settings

Selecting a Failure Action determines what action is taken when a measurement fails in a sequence – for example, when the upper limit of a result is exceeded. Four types of failure actions are available:

1. Continue Sequence. By default, measurements are configured to Continue the next measurement upon failure, flagging failures that occur in both the Sequencer as well as generated reports.
2. Cancel Sequence. This option immediately aborts the entire sequence upon failure. Measurements following the failed measurement are not run or included in reports.
3. Prompt for Retry. When selected, Prompt for Retry displays a dialog with options to Abort, Retry, or Ignore any failures that occur.
4. Auto Retry. The Auto Retry setting automatically re-attempts a failed measurement a set number of times until the measurements succeeds – up to 5 times.

Measurement Sequence Settings for a measurement or signal path can be accessed by selecting a measurement in the Navigator and then clicking the “Measurement Sequence Settings…” node immediately below the measurement name.

Multiple Sequences

The ability to have multiple sequences within a project is one of the features that supports automation of electro-acoustic tests. In Figure 9, three sequences have been created, named Calibrate, Golden Unit and Test Speaker. Each of these sequences is just a different subset of all the items present in the Navigator. These sequences enable the related but different operations of calibrating equipment, testing Golden Units, and testing the DUTs; typical operations necessary for production test of electro-acoustic devices.

The first sequence, Calibrate, will run the first two signal paths. The first signal path is used to set the generator dBrG reference to 2.83 Vrms (the voltage corresponding to 1 W into 8 Ω) and the second signal path is used to calibrate the attached measurement microphone by reading its TEDS data.

The second sequence in Figure 9, Golden Unit, runs the measurement named “AR Golden Unit” in the signal path named “Signal Path3 – Acoustic Measurements.” This measures the frequency response of a reference device.
using several averages and exports the data to a series of files using variables to create the file path specifications.

The third sequence in Figure 9, Test Speaker, runs the measurement named “AR DUT” in the signal path named “Signal Path3 – Acoustic Measurements.” This measurement imports the frequency response data from the last Golden Unit measurement and creates new limits from it.

**Adding Sequences**

To add a sequence, expand the Sequence drop-down at the top of the Navigator/Sequencer and select “Create new...” (Figure 10). Alternatively, click the Add/Edit Sequences button in the Sequencer toolbar to add, rename, delete, or reorder sequences using the Edit Sequences dialog (Figure 11).

**Editing Sequence Properties**

Each sequence has a variety of properties which can be viewed or edited using the Edit Sequences button adjacent to the Sequence selector. See the sections titled “Production Test Mode” and “Auxiliary Control” for a discussion of these settings.

**Variables**

In APx, variables are used to store information related to operators, devices, measurements, timestamps, and more, and are often used in file paths and filenames to provide flexibility and compatibility across systems.

APx supports a comprehensive set of variables which can be used when building automation projects. To see the list of variables, open the Project Properties dialog from the Project menu and choose the Variables tab (Figure 12).

Five classes of variables are supported:

**Class 1: User defined variables**

To add a user defined variable, click the Add User Defined Variable button on the left side of the Variables tab (Figure 12) and assign a variable name. Variable values can be set by entering the value in the dialog, or in a sequence via a sequence step; an example would be an operator entering a value in the input field of a prompt. Alternatively, the drop-down to the right of the Value field can be used to browse to a file or a folder, if needed, in lieu of typing a variable value.
**Class 2: APx System Variables**

This class includes a number of variables representing APx-specific items such as the current signal path name, current measurement name, device ID, APx project file directory, etc.

**Class 3: Measurement Variables**

This class includes variables whose values are populated when a measurement is run. For example, measurement variables store TEDS data read from attached microphones when a TEDS Data measurement or Calibrate from TEDS step is run in a sequence.

**Class 4: Environment Variables**

This class includes an extensive set of the Windows system environment variables, such as the computer name, username, Windows folder name, etc.

**Class 5: System Folders**

This class includes an extensive set of variables representing special Windows System folders on the PC.

**Variable Properties: Required and Persist**

Variables have Required and Persist properties, which come into play when the variables are used in prompt sequence steps (Figure 13).

The Required property of a variable specifies that the operator must provide a response; the Persist property, when enabled, tells APx to populate the Response field of the prompt with the previously entered value. In the example shown above, the Model is both required and persistent. The operator enters the model number once, on the first sequence run. The Model field of the prompt is then pre-populated for all subsequent sequence runs, as shown in Figure 14.

The Speaker ID is also required, but it is not persistent. Its response field will be blank at the start of each sequence run, ready for the operator to enter each speaker serial number.

Variables used in a measurement prompt in APx also flow into the APx test report.

**Using Variables in Paths**

Variables offer great flexibility in setting up automated test projects, especially in building file path specifications. For example, you can easily create variables representing the part number, lot number and serial number of the DUT and encode these variables into the names of folders, data files, limit files, and reports, complete with a date and time-of-test timestamp. They are also useful for specifying the path to external programs in a Run External Program sequence step.

To illustrate, the Export Result Data shown in Figure 15 is configured to export a frequency response data set to a file whose path is constructed from variables representing the model and serial number of the current device. For this to work, the variables must be set before the export step is executed (e.g., via a prompt step).
Variables can be inserted into a path via the “Use Variables...” picker (accessed using the drop-down to the right of the field) or by manually typing the variable name using the format "$(VariableName)" (without the quotations).

When executed in a sequence, variable names entered in sequence steps are resolved to their values. In this example, the frequency response data set is exported to the path “C:\Data\Model_QC497A\13345_FrequencyResponse.xlsx”. If the variable values are invalid for a file path, or are not set, the sequence will abort with an error.

Auxiliary Control
General-purpose input/output (GPIO) ports (available on most APx analyzers, including the APx517) provide the capability to communicate with external devices, receiving and transmitting control commands. This functionality is known as Aux Control Input and Aux Control Output, respectively.

Aux Control Input can be used to initiate software actions (for example, pressing an OK button in a prompt) when a designed bit pattern is received on the aux input port. Perhaps the most common usage is configuring a sequence to start when a foot switch is pressed (emitting a bit pattern of 0000 0001, or 1000 0000).

Conversely, Aux Control Output can be used to initiate an action in an external device, for example, switching a relay to indicate the pass or fail status of a sequence in a color-coded LED lamp or other connected device.

Aux control settings exist in a few different contexts, including:

**Aux Control Sequence Settings**
Accessible from the Edit Sequences dialog using the Aux Control “Settings...” button, Aux Control Sequence Settings specify the aux control output state set at the beginning or end of a particular sequence, as well as the aux control input state required to automatically start the sequence. In the example configuration shown in Figure 18, the sequence will start when input bit 1 is high, at which point the state of the last four output bits will be changed to 0001.
Dialog Button Aux Control Settings
Accessed from the Project→Sequencer Properties menu item under the Dialog Button Aux Control tab, these settings associate specific aux input bit patterns with user inputs such as “OK” and “Cancel”, enabling an external device to continue or a cancel a sequence. In the example configuration shown in Figure 19, a prompt opened in a sequence will be dismissed as “OK” when aux input bit 1 is high or “Cancel” when Aux input bit 2 is high.

The Set Aux Control Output Step
Available as a pre-, post-, or measurement sequence step, this step sets the state of the aux control output bits to whatever values are specified in the step’s settings. In the example configuration shown below, all bits will be reset to 0 (low).

Exporting data and reports
Oftentimes, production test designers find it necessary to log pass/fail information, acquired data, and other information pertaining to each DUT for post-processing or review.

In APx, this can be done in three ways:

Export Steps
An Export Result Data step exports a single XY, meter, or tabular result to an XLSX, CSV, or MAT (MATLAB) data file using the points defined in the selected Data Specification (Figure 21).
exported data files using the “Insert Variable in Header” setting, if desired.

An export step can be configured to either append to or overwrite an existing data file, if it already exists. If appended, a setting is available to append the Y Data Only. This is a useful feature when exporting to XLS or XLSX files in particular. When selected, appended measurement results are added to a worksheet tab as additional columns, and the X-axis data, which is common to all appended measurements, only shows up in the first column of the worksheet. See Figure 22 for an example of a worksheet in an XLSX file created by running the sequence containing the Export Data step in Figure 21 multiple times.

Data export specifications define the range and number of points exported by sequence steps when a sequence is run. Once added, export specifications become part of the APx project file and can be used to export any XY result of a similar type. Export specifications have settings to select all the points within a certain range, or a specific set of points in a range, using either logarithmic or linear spacing.

For example, Figure 23 shows an export specification defined for a Frequency Response Relative Level result. The specification, named “200PSO-10k.xyspec”, specifies 200 points logarithmically spaced between 200 Hz and 10 kHz. Once created, this specification can be used anywhere in the project to export frequency response data. For another example, to save frequency response data at standard 1/24-octave frequencies, simply create a data export specification with a Custom step type and specify the standard 1/24-octave frequencies within range—or, better yet, import them from a worksheet file.

To configure which points will be exported by an Export Result Data step, expand the step’s Data Specification drop-down and select an existing specification, or alternatively select “Create New...” to define a new one.

Data export specifications within a project file can be managed from the “Manage Attached Project Items...” dialog, available from the File menu. This dialog shows where in the project the specification is used and provides controls to export, replace and delete export specifications.

**The Report Step**

The Report post-sequence step, when checked, generates a detailed report containing information pertaining to the overall pass/fail status of the sequence, the status of each individual measurement and result, the signal path and measurement configurations, as well as the acquired data and defined limits.

Settings for a report can be viewed or edited by right clicking the Report post-sequence step and choosing “Properties...”. 

---

**Figure 22. XLSX file exported from multiple sequence runs.**

**Figure 23. An Export Data Specification.**
By default, an APx report is generated using the “APx Default Layout”. This setting creates a multipage report with graphics in the standard APx style that can be viewed in an APx window. While the default layout can be modified somewhat using the “Options” and “Margins” settings, fully customized layouts can be created using the “Microsoft Word” layout. The Microsoft Word report type requires more effort in formatting, but is also the most flexible.

Settings shown on the Auto-Save tab of the Edit Report Properties dialog specify whether the report is auto-saved or displayed at the end of a sequence, or both. Like data files, variables can be used to specify the report file path or name, if desired.

Reports saved to PDF, HTML, or RTF files mirror the layout shown in the APx report viewer (or Word document, when using the Microsoft Word layout) and display x/y graphs as images, whereas reports saved to XLSX, CSV, or MAT export the underlying data points instead of images.

**The Data Output step**

The Data Output node, when checked, appends data acquired in a sequence to a specified CSV file. Each time the sequence is run, all checked meter results (single value results) are appended to the CSV file as a new row with date and time stamp. Limit information and DeviceId are also included, if defined.

**Loudspeakers & Headphones—Special Requirements for Production Test**

Electro-acoustic (EA) devices (loudspeakers, headphones, microphones, and so on) often have special requirements for production test. These requirements can include:

1. Periodic calibration of one or more measurement microphones.
2. Automatic regulation of a device’s output level to a target sound pressure level.
4. Defining a voltage limit for analog generators to protect connected devices.
5. Applying an input equalization curve to compensate for a microphone’s response.

A description of the software features that implement these requirements follows.

**Microphone Calibration**

Measurement microphones are transducers that convert sound pressure fluctuations to a voltage signal. When measuring such acoustic signals with a measurement microphone, the analyzer must account for the microphone sensitivity, so that it can properly scale the microphone voltage signal to represent sound pressure. Microphone sensitivity is typically reported in units of volts per pascal (V/Pa). The process of entering the microphone sensitivity is sometimes referred to as “calibrating the microphone”. In APx, this can be done by one of three methods:

1. Manually typing in the microphone sensitivity.
2. Using a sound level calibrator to generate a known sound pressure level (SPL). The analyzer captures the voltage produced by the microphone due to the calibrator’s known SPL and calculates the sensitivity from it.
3. Reading the sensitivity from the microphone directly (if the microphone is equipped with a Transducer Electronic Data Sheet – TEDS – and the analyzer has TEDS support).

Sequence steps are available for methods 2 and 3, above.

**Acoustic Input Mode**

Before calibrating, analog inputs to the analyzer should be defined as either Acoustic or not Acoustic based on the types of signals being measured.

![Input Configuration](image)

**Figure 24. The Acoustic input setting.**

When Acoustic input mode is enabled, analog input voltages on all channels are assumed to represent acoustic signals. Results plotting measured level, as well as input settings relating to measured level, are displayed exclusively using units of sound pressure level (Pa or dBSPL) using V/Pa sensitivities defined on a per-channel basis. As such, electrical impedance measurements cannot be made when Acoustic input mode is enabled.
When Acoustic input mode is disabled, results and settings pertaining to measured level are represented as voltages by default but can optionally be displayed as SPLs using the referenced dBSPL1/dBSPL2 input units (Figure 25). In this technote, calibration procedures are demonstrated with Acoustic input mode disabled.

Figure 25. The unit selector of a measurement result.

Per-channel sensitivities and dBSPL1/dBSPL2 reference settings can be manually configured or viewed via the Microphone Calibration / Set dBSPL dialog shown in Figure 26).

Figure 26. The Microphone Calibration / Set dBSPL dialog.

A description of the two microphone calibration methods available as Sequence Steps (TEDS and using an acoustic calibrator) follows.

**Calibrating from TEDS**
The Calibrate from TEDS step (available in Signal Path Setup) reads the sensitivity of an attached microphone from its embedded TEDS chip and applies it to the selected dBSPL reference (Figure 27). Calibrating from TEDS is only available on APx analyzers and accessories with TEDS capable microphone inputs, such as the APx517 and the APx1701 Transducer Test Interface.

Figure 27. The Calibrate from TEDS step.

**Using an Acoustic Calibrator**
Alternatively, a Prompt step added to the Signal Path Setup measurement can be used to calibrate a microphone using an acoustic calibrator. Before doing so, the calibrator’s reference SPL should be entered in the appropriate Calibrator Level field in Microphone Calibration / Set dBSPL1, dBSPL2 field (Figure 26). The prompt should instruct the operator to apply the calibrator to the microphone and click OK when the measured level is stable. In the prompt step, the Set dBSPL1 or Set dBSPL2 checkbox should be checked, and the appropriate Channel selected, as shown in Figure 28. In this example, the microphone’s sensitivity will be calculated and assigned to the dBSPL1 reference based on the level measured on Channel 1.

Figure 28. Prompt calibration example.

**Output Level Regulation**
In some test applications (for example, when testing microphones), the output of a loudspeaker or other electro-acoustic device is often regulated to a target SPL at a given reference frequency before measurements are made – most commonly, 94 dBSPL at 1 kHz.
To automatically regulate an acoustic output to a target level in a sequence, regulation parameters must first be defined in the Automatically Set Generator Level dialog, accessed from the Signal Path Setup References panel (Figure 29).

Once the parameters have been set, the regulation process can be configured to automatically run in a sequence by checking the “Auto Set Generator Level” checkbox in the Measurement Sequence Settings node of Signal Path Setup (Figure 30).

**Defining Limits/Targets Using Golden Units**

Due to the nature of their component materials and how they are assembled, loudspeakers can be highly nonlinear. This nonlinearity can cause measurement results to vary widely because of the fluctuations in temperature and humidity that can occur in a production environment. To compensate for these variations, manufacturers often use one or more Golden Units in production test. These reference devices (loudspeaker drivers, in this case) are representative of a good sample of the part being tested. Periodically (e.g., once or twice per work shift), the reference devices are tested on the line to re-establish the performance target under current ambient conditions. Subsequently, production part test results are compared to the reference device measurement until the next scheduled reference measurement (e.g., at the beginning of the next work shift). By continually comparing production units to the reference unit tested in the same environment, these variations due to temperature and humidity are “backed out” of the process.

The use of reference devices in production test brings special requirements, such as the ability to change test limits on the fly. **The Import Limits Data Step**

In APx, limits can be updated before a measurement is run in a sequence using the Import Limits Data step. When an Import Limits Data step is added to the Sequence Steps node of a measurement, the dialog shown in Figure 31 opens to enable configuration of the step.

The “To Result” menu is used to select which measurement result the limits will be imported to, and the “From File” field is used to specify the source file for the imported limits data. As with other path fields, variables can be used to specify the limits data file path. For example, in Figure 31, variables are used to set the limits data file path to an Excel file saved when the last Golden Unit measurement was conducted.
The Apply Limit controls are used to create limits from the imported data. The imported data curve can be applied to the upper limit, lower limit, or both limits, with an optional offset. You can use the offset controls to specify an offset curve that will be combined with the imported data to create the limit. The Offset menu initially has choices of None, Create New, and Browse for file. The Create New selection will invoke the Edit Limits Offset Curve dialog. Initially, for a frequency sweep measurement like Acoustic Response, this curve will have two points at the start and stop frequency of the sweep. You can specify a simple constant offset by assigning the same value to the two frequencies. Alternatively, you can specify a more elaborate offset curve (for example, as shown in Figure 32) by adding more points.

Figure 32. Specifying the Limit Offset Curve.

Using the Apply Limit controls, it’s easy to create a set of symmetric limits. Two methods of comparing a sample of the DUT to the Golden Unit curve are commonly used:

- Using the measured response curve
- Using a comparison of the DUT response to the Golden Unit response

In the first, limits are created based on the measured frequency response of the Golden Unit. Figure 33, below, shows an example of this method. The symmetrical limit curves (red traces) were formed by offsetting a measured Golden Unit curve by the limit offset curve shown in Figure 32, above. In this case, the lower limit was formed by inverting the offset curve using the Invert check box next to the Offset controls for the lower limit.

Figure 33. Symmetric limits created by applying a measured Golden Unit curve with the offset curve of Figure 32 to the Relative Level result.

**The Compare Ratio derived result**

The second method is based on a comparison of the DUT’s frequency response curve to the Golden Unit’s frequency response curve. A Compare derived result can be created for this purpose. The compare operation divides the curves on a point-by-point basis (a subtraction when using decibel units). An ideal DUT whose response exactly matches the Golden Unit would result in a comparison curve that is a flat line with a level of 0 dB at all frequencies. Figure 34 shows an example of such a comparison curve with symmetric limits. In this case, the limits were created by using the offset curve of Figure 32 as the limit data. For the lower limit, the curve was inverted by checking the Invert Data check box above the Offset control.

Figure 34. Symmetric limits created by applying the offset curve of Figure 32 to a Compare derived result (DUT response compared to Golden Unit response).

**Analog Generator Global V<sub>max</sub>**

Global V<sub>max</sub> settings provided in the Project Properties dialog provide the ability to configure a global not-to-exceed voltage limit for analog generators defined in...
measurements (Figure 35). This is a safety feature to avoid inadvertently generating a voltage that could damage sensitive devices like loudspeakers and headphones. Global \( V_{\text{max}} \) settings override generator settings anywhere in an APx project file.

**Input EQ**

Input EQ (equalization) curves can optionally be applied to compensate for microphones with a non-flat frequency response. High-quality measurement microphones are typically flat within ±1 dB or less over the audio band and do not require equalization. However, there are situations in which an input EQ is required. One such case is testing headphones using ear simulators in a Head and Torso Simulator (HATS).

To specify an input EQ curve, click the EQ pulldown in the Filters section of the Input Configuration controls (Figure 36) and select Browse for file or Create New to open the Edit EQ Table dialog (Figure 37). Here you can import a microphone EQ table, or create one by entering points or drawing them on the EQ curve.

Figure 35. Global \( V_{\text{max}} \) controls in the Project Properties dialog.

Figure 36. Input EQ controls in Signal Path Setup.

Figure 37 shows Edit EQ Table dialog after importing the EQ curve of a popular, inexpensive microphone. To equalize the system to compensate for this non-flat frequency response, we need to invert this curve. You can invert the curve by simply clicking the Invert button above the EQ curve, in the graph toolbar (Figure 38).

Figure 37. The Edit EQ Table dialog with an imported microphone EQ curve.

Figure 38. The EQ curve of Figure 37 inverted.

The Channels button beside the EQ control in the Input Configuration section (Figure 36) allows you to specify to which input channels the EQ curve should be applied.

**Production Test Mode**

Production Test mode offers a means of interacting with the APx software that offers several advantages over the traditional APx user interface (UI) for production test applications. These include:

- A much simpler UI for test operators: a Production Test main “menu” consisting of a simple dialog window with a button for each sequence and an optional banner image (e.g., Figure 39).
- The option to display or hide the full APx UI while in Production Test mode.
- The ability to password-protect select sequences.
- Sequence looping: if all measurements in the sequence pass limits, the sequence can be automatically repeated.
- A user-selectable number of retries if any measurement in the sequence fails.
- An optional sequence log file that can be used to keep a record of sequence runs, complete with pass/fail statistics and other variables.

To configure the Production Test main menu, double-click on the Sequencer Properties node in the Navigator to open the Sequencer Properties dialog (Figure 40). Here you can enter the text for an operator instruction that will appear on the Production Test main menu and choose an optional graphic for it that will appear as a banner image. The default instruction is “Select a button to start a test sequence.”

Each active sequence within the project will have a button on the Production Test main menu. You can use the Edit Sequences dialog (Figure 11, page 7) to configure the Production Test properties for each sequence (whether a password is required, sequence looping when all measurements pass, and optional retries when a measurement fails).

To enter Production Test mode, you must lock the project by entering a password.

Note: The same password is used for password-protected sequences.

The Lock Project dialog is available from the lock icon to the right of the Sequence field at the top of the Navigator (Figure 41), or from the Lock Project selection on the File menu. Simply check the Production Test check box when locking the project. A second check box is available to select the choice of whether the APx main application window will be visible or hidden in Production Test mode.
Sequence Log File and Statistics

Sequence log files can also be configured to keep a running log of pass/fail statistics each time a sequence is run. To configure this log file, check the checkbox in the Sequence Log File section of the Edit Sequences dialog (Figure 42) and specify a CSV file for the sequence log.

The Choose Variables and Statistics button will open a dialog (Figure 43) where you can select the project variables and statistics to be written to the log file when a sequence is run. A large number of statistics are available, including Cycle Count, Passed Count, Failed Count, First Pass Yield, etc. Figure 44 shows an example of a log file created by running the production test project for several sequences.

In this case the CSV file has been opened and formatted using Excel.

Putting It All Together

The sample project featured in this technote has three sequences, Calibrate, Golden Unit and Test Speaker. The Calibrate and Golden Unit sequences have been configured to require a password. The Test Speaker sequence in this project runs an Acoustic Response measurement at rated power, followed by a Loudspeaker Production Test measurement at 20 dB below rated power to measure Thiele-Small parameters. If the DUT passes limits, the Test Speaker sequence is automatically run again, starting at the prompt to scan the next DUT’s barcode.

Figure 45 shows the progress dialog during a run of the Test Speaker sequence in this example project, when no measurements have yet failed limits. As shown, when each measurement is complete, the dialog lists the measurement name with a pass/fail indicator beside it. A progress bar shows the status of the running sequence, and a table of the most recent pass/fail statistics is displayed.

Figure 46 shows the same progress dialog at the end of the sequence. As shown, if any measurement has failed limits, the pass/fail indicator beside its name indicates a failure, and the progress bar changes to a solid red bar indicating that one or more measurements has failed limits. In this case the operator can choose End Sequence, Retry or Next Device. The Unlock and Exit App buttons from the Production Test main menu are also available here.
Summary

The automated test features built in to the APx500 measurement software make it easy to create production test systems without the need to write any code. For users with special or uncommon requirements not addressed by the built-in automation features, a fully-featured Microsoft .NET-based application programming interface (API) is available.

This concludes our discussion of the production test features in the APx500 control software. While the examples in this technote focused on electro-acoustic production test needs, many of these features are equally useful for automated testing of any type of device.